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            (2½ Hours )              [Total Marks: 75]
           

Note: 1) All questions carry equal marks and are compulsory. 
           2) Figures to the right indicate maximum marks for a question.  
            

Q1.  (A)  Attempt  any two  sub-questions from a), b) and c) in MS-EXCEL 
(True or False) 

(2) 

  a) Worksheets can be linked with each other only if they are in different 
workbook. 

 

  b) The legend on a chart can be removed  
  c) Solver and goal seek are used for the same purpose in Excel.  
     
 (B)  Attempt  any two  sub-questions  from d), e), f) in VISUAL BASIC 

(Multiple Choice) 
(2) 

  d) ______________ is an event driven language.  
   A) C B) C++ C) BASIC D) VISUAL BASIC  

  e) The standard prefix for Command button is ________.  
   A)comd   B)cmd                   C) com                        d)cbo  
  f) _______is a part of Visual Basic IDE.  
   A) Code window B) Properties window  
   C) Project Explorer window D) All of the above.  
     
 (C)  Attempt any six  sub-questions from g), h), i), j), k), l), m), n), o) in  

E-Commerce. (True Or False). 
(6) 

  g) In the subscription model a fee is charged to the user for having access to 
material on the website. 

 

  h) E- Market, EDI and Internet are parts of E-Commerce.  
  i) The volume of B2B transactions being done is more than B2C 

transactions. 
 

  j) Banners and sponsorships are examples of subscription revenue model.  
  k) Authenticity refers to the ability to determine the origin of the message 

received over the internet. 
 

  l) Encryption covers all the security issues.  
  m) Digital signature changes for every document.  
  n) In SSL the URL changes to HTTPS from HTTP.  
  o) Digital cash is the electronic parallel of notes and coins.  
     
 (D)  Attempt any five  sub-questions from p), q), r), s), t), u), v), w) in E-

Commerce. (Multiple Choice) 
(5) 

  p) _________segment of E-commerce focuses consumers dealing with each 
other. 

 

   A) B2B        B) C2B c) C2C D) B2C  

  q) Buying and selling products on the internet is called_____________  
     A) EDI B) E-Commerce C) E-Business D) E market  

 
  r) E-tailer model is__________ revenue model.  
   A) Sales B) Subscription C) Advertising D) Affiliate 
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  s) The sender and receiver will have the same key in _________Key encryption  
   A) Symmetric B) Asymmetric C) Public D)Private  
  t) ______________ means converting cipher text to plain text.  
   A) Encryption B) Decryption  
   C)Conversion D)De-conversion  
  u) The full form of WAP in E-Commerce is Wireless ___ Protocol.                
   A)And B)App C)Application D)Area  
  v) Ebay.com is _________  
   A) onlyB2B B) only C2C C) onlyB2C D) both B2B and B2C  
  w) When you make a payment using PayPal, you have to e-mail the payment 

to merchant’s_____________ account 
 

   A) Current B)Saving C)PayPal D)None of these  
     
Q2. (A)  Answer any one sub-question from a) and b) in E-Commerce. (8) 
  a) Explain the features of E-Commerce.  

 
 

  b) Explain the following B2C models in E-commerce. 
 (i)   E-Tailer                               (ii) Content Provider         
 (iii) Transaction Broker        (iv)Market Creator 

 

     
 (B)  Answer any one sub-question from c) and d) in E-Commerce. (7) 
  c) Discuss the various security issues in E-Commerce.  

 
 

  d) Explain how an Online Credit Card Transaction Works?  
      
Q3. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 

 
  a) Consider the following worksheet 

 A B C D E 

1 NAME CITY SALES COMMISSION BONUS 

2 RAHUL MUMBAI 80000   

3 ANJALI PUNE 100000   

4 POOJA BANGLORE 50000   

5 RAJ HYDERABAD 95000   

6 KAJOL PUNE 200000   

7 ADITYA BANGLORE 300000   

8 SEEMA HYDERABAD 40000   

 
Write Steps to perform the following: 
i) To compute Commission @8% of sales whenever sales are below 

`75,000 otherwise @ 10% of Sales in column D. 

ii) To compute the Bonus as 2% of the Sales for Sales up to `50,000 

otherwise @ 5% of Sales in column E.  
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  b) The following data has been entered in a worksheet. 
 

 A B C D E F G 
1 NAME TEST1 TEST2 TEST3 TEST 4 AVERAGE 

MARKS 
GRADE 

2 SAMIRA 66 77 70 70   
3 SAIRA 56 67 72 77   
4 NASIR 45 54 55 60   
5 NITIN 40 45 48 56   
6 SARITA 67 78 80 85   
7 ADIL 65 66 69 78   

Where Test1, Test 2, Test 3 and Test 4 are marks scored by the 
candidates in 4 tests.  
Write steps to  

i) Find the Average marks in column F. 
ii) Assign Grade in Column G using the following policy: 

Average Marks Grade 
80  or more O 
60 or more but below 80 A 
Less than 60 B 

 

 

     
Q.3 (B)  Answer any one  sub-question from  c) and  d) in MS-EXCEL 

 
(7) 

  c) The following data has been entered in a worksheet. 
 A B C D E F G H 

1 NAME DESIGNATION HRA DA  DESIGNATION HRA DA 

2 SONU  PEON    PEON 4000 5000 

3 PINKY CLERK    CLERK 8000 10000 

4 RINKU CLERK    MANAGER 15000 20000 

5 SOPHIE MANAGER       

6 PREM PEON       

7 BINDU CLERK       

8 TINA MANAGER       

 

Write steps to find the HRA and DA in column C and D respectively using 
VLOOKUP function. Policy table to be referred for finding the HRA and DA 
is given in the range F2:H4. 
 

 

  d) 
 

Consider the following worksheet 
 A B C D 

1 NAME MONTHLY SALARY ANNUAL INCOME INCOME TAX 

2 RAHUL 80000   

3 ANJALI 100000   

4 POOJA 50000   

5 RAJ 65000   

6 KAJOL 40000   

7 ADITYA 125000   

8 SEEMA 40000   

 

 



Q. P. Code: 26878 
 

Page 4 of 5 
 

Write steps to calculate Annual Income in column C and Income Tax in 
column D where Income-Tax is calculated as follows. 
 

       Taxable Annual Income       Rate 
         First 1,00,000         Nil 
         Next 2,00,000        10% 
         Excess        20% 

 

     
Q4. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL 

 
(8) 

  a) The following data is entered in a worksheet regarding expenses (in `) 

during January, February, March and April. 
 

 A B C D E 
1 ITEM JAN FEB MAR APRIL 
2 EDUCATION 6000 6000 6000 6000 
3 FOOD 15000 16000 17000 16000 
4 RENT 45000 45000 45000 45000 
5 CAR 12000 15000 13000 14000 
6 TOTAL     

 
Write the steps to 
 i) Find the total expenses in each month in the cells B6, C6, D6 and E6. 
ii) Create 3-D Bar chart for expenses of January, February, March and 
April. 
iii) Create a Pie chart for the month of March. 
iv) Create a Line diagram for the months February and April. 
 

 

  b) The following table shows Quantity, Unit Price, Income and total Income 
of a shopkeeper who sells rice, dal, sugar and tea. 
 

 A B C D E 
1 ITEM QUANTITY PRICE INCOME  
2 RICE 100 80 8000  
3 DAL 50 120 6000  
4 SUGAR 60 70 4200  
5 TEA 45 250 11250  
6      

 
Write steps to find Total Income in D6.   
Write steps in Excel using Solver to find how much quantity of rice, dal, 

sugar and tea should be sold in order to achieve total income of `50,000, 

assuming that quantity should be integer only. 
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Q4. (B)  Answer any one  sub-question from  c) , d) in MS-EXCEL (7) 
  c) The following data has been entered in a worksheet 

 A B C D 

1 EMPNO NAME SALARY INCOME TAX 

2 E001 DOLLY 35000  

3 E002 ANJALI 55000  

4 E003 DIPALI 42000  

5 E004 RAJ 50000  

6 E005 KAJOL 52000  

7 E006 ADITYA 75000  

8 E007 REEMA 60000  

 
Write steps to do the following:- 

i) Display only those rows where the Salary is more than ` 50,000. 

ii)Display only those rows where the Salary is more than `45,000 but  

    less than `65,000. 

iii) Display only those rows where name do not start with “M”. 
 

 

  d) Explain the following functions in MS-EXCEL. 
   

1) TODAY( ) 2) COUNTBLANK( ) 3) SMALL( ) 4) YEAR( ) 
5) CORREL( ) 6) WEEKDAY( ) 7)DAY( )  
    

 

 

     
Q5. (A)  Answer any one  sub-question from  a) and b) in VISUAL BASIC 

 
(8) 

  a) Write a project in VB to accept students name and marks in Accounts, 
Economics and MHRM.  Calculate and display total mark and percentage. 
 

 

  b) Write a project in VB to design a suitable form which allows a user to enter 
three numbers in text boxes. Find and display the maximum number 
among them.  

 
 

     
Q5. (B)  Answer any one  sub-question from  c) and d) in VISUAL BASIC (7) 
  c) Write a project to design a suitable form to allow the user to enter name of 

salesperson and the total sales. Calculate and display the commission 
earned by the salesperson based on the following table. Use appropriate 
controls.  
 

Total Sales(Rs) Commission 
Less than or equal to 90,000 Nil 
Between 90,000 and up to 1,50,000 10 % 
More than 1,50,000 12% 

 

 

  d) Write a project in VB to compute and display the sum of the series 
2 + 5 + 8 + 11 + ⋯ + 32 

 
 

     
******** 
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            (2½ Hours )              [Total Marks: 75]
           

Note: 1) All questions carry equal marks and are compulsory. 
           2) Figures to the right indicate maximum marks for a question.  
            
Q1.  (A)  Attempt  any two  sub-questions from a), b) and c) in MS-EXCEL 

(True or False) 
(2) 

  a) Worksheets can be linked with each other only if they are in different 
workbook. 

F 

  b) The legend on a chart can be removed T 
  c) Solver and goal seek are used for the same purpose in Excel. F 
     
 (B)  Attempt  any two  sub-questions  from d), e), f) in VISUAL BASIC 

(Multiple Choice) 
(2) 

  d) ______________ is an event driven language.  
   A) C B) C++ C) BASIC D) VISUAL BASIC  

  e) The standard prefix for Command button is ________.  
   A)comd   B)cmd                   C) com                        d)cbo  
  f) _______is a part of Visual Basic IDE.  
   A) Code window B) Properties window  
   C) Project Explorer window D) All of the above.  
     
 (C)  Attempt any six  sub-questions from g), h), i), j), k), l), m), n), o) in  

E-Commerce. (True Or False). 
(6) 

  g) In the subscription model a fee is charged to the user for having access to 
material on the website. 

T 

  h) E- Market, EDI and Internet are parts of E-Commerce. T 
  i) The volume of B2B transactions being done is more than B2C transactions. T 
  j) Banners and sponsorships are examples of subscription revenue model. F 
  k) Authenticity refers to the ability to determine the origin of the message 

received over the internet. 
T 

  l) Encryption covers all the security issues. F 
  m) Digital signature changes for every document. F 
  n) In SSL the URL changes to HTTPS from HTTP. T 
  o) Digital cash is the electronic parallel of notes and coins. T 
     
 (D)  Attempt any five  sub-questions from p), q), r), s), t), u), v), w) in E-

Commerce. (Multiple Choice) 
(5) 

  p) _________segment of E-commerce focuses consumers dealing with each 
other. 

 

   A) B2B        B) C2B c) C2C D) B2C  

  q) Buying and selling products on the internet is called_____________  
     A) EDI B) E-Commerce C) E-Business D) E market  
  r) E-tailer model is__________ revenue model.  
   A) Sales B) Subscription C) Advertising D) Affiliate  
  s) The sender and receiver will have the same key in _________Key encryption  
   A) Symmetric B) Asymmetric C) Public D)Private  
  t) ______________ means converting cipher text to plain text.  
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   A) Encryption B) Decryption  
   C)Conversion D)De-conversion  
  u) The full form of WAP in E-Commerce is Wireless ___ Protocol.                
   A)And B)App C)Application D)Area  
  v) Ebay.com is _________  
   A) onlyB2B B) only C2C C) onlyB2C D) both B2B and B2C  
  w) When you make a payment using PayPal, you have to e-mail the payment 

to merchant’s_____________ account 
 

   A) Current B)Saving C)PayPal D)None of these  
     
Q2. (A)  Answer any one sub-question from a) and b) in E-Commerce. (8) 
  a) Explain the features of E-Commerce.  

Give full marks if any four features of E-Commerce explained. (2 marks for 
each feature) 
The important features of E-Commerce as listed below. 
Ubiquity: 
When we say that E-Commerce is ubiquitous, it means that it is available 
just about everywhere and at any time. It removes the boundaries of space 
and makes it possible to shop from the confines of your home or office and 
even when travelling by various modes of transport. Hence it liberates the 
market from any physical space that we normally associate with carrying 
out commerce. 
Global Reach: 
E-Commerce technology permits commercial transactions to cross various 
cultural boundaries, as well as the geographical boundaries that have been 
made by mankind across the globe. Hence the size of the market that is 
available for E-Commerce includes the entire population which is going 
online.  
Universal Standards: 
The technical standards used in E-Commerce are universal standards i.e. 
they are used all over the world. This is chiefly due to the fact that the 
technical standards used in the internet are universal standards, which are 
accepted and shared all over the world.  
The use of these universal standards in E-Commerce has resulted in a great 
reduction in the costs involved in searching for products, as they can be 
viewed by one and all.  
Interactivity: 
 The technologies used in E-Commerce are interactive i.e. they allow a two 
way communication between the parties involved in the transaction, which 
are the merchant making the sale and the buyer. For example, a website 
may ask the consumer to fill in a form and depending on the data entered 
in that form, various options are displayed, from which the consumer can 
choose the appropriate one.  
Richness: 
Richness refers to the complexity and content of information on a product, 
which is traded in E-Commerce. Using audio and video the richness of the 
information that is given is greatly enhanced. This, in turn, becomes a 
powerful tool for selling in the commercial environment. 
Information Density. 
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Information density refers to the total amount and quality of information 
that is available to all the stakeholders (market participants, consumers 
and merchants). The wide use of E-Commerce has greatly reduced the cost 
of collection of information, its storage, processing and communication.  
Personalization. 
This enables the merchants and traders to have better information of the 
requirements in the market, due to which they can modify their marketing 
strategies. Due to the interactive nature of technology used in E-Commerce, 
the past preferences and behavior of the user is known. This enables 
merchants to customize i.e. give the product or service as desired by the 
user. 

  b) Explain the following B2C models in E-commerce. 
 (i)   E-Tailer                               (ii) Content Provider         
 (iii) Transaction Broker        (iv)Market Creator 
TWO Marks each, Give full marks if any two points are given. 
(i) E-tailer : 
The customers and the seller interact directly, it includes 
• Organize an online catalogue of products 
• Take orders through Web site 
• Shopping cart technology 
• Accept payments in a secure environment 
• Send merchandise to customers 
• Manage customer data 
• Market Web site to potential customers 
• Revenue through product sales 
• Low barriers to entry -> very competitive 
(ii) Content providers : 
Content providers distribute digital content (news, music, video and 
artwork) over the Web. Revenue is generated through subscription fees, 
pay for download, or advertising.  
(iii) Transaction Broker : 
Sites that process transactions for consumers. It primary value proposition 
is saving of time and money for customers. It is a typical revenue model 
with a transaction fee is charged for facilitating transactions.  
Industries using this model: 
• Financial services 
• Travel services 
• Job placement services 
(iv) Market Creator : 
Market creator model uses internet technology to build markets where 
buyers and sellers can meet, decide on a product and fix the price for that 
product. The web has made it possible to delink markets from physical 
space. Ebay.com is one such market place. Ebay.com earns revenue by 
charging a fee to list the product and also a fee on such sale. Digital market 
place has to attract many buyers and sellers otherwise the model will not 
be feasible.  

 

     
 (B)  Answer any one sub-question from c) and d) in E-Commerce. (7) 
  c) Discuss the various security issues in E-Commerce.   
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If any 3 relevant points are written give full 7 marks 
One of the things that have slowed down the growth of E-Commerce is the 
problems of security. Many of those who would like to use E-Commerce are 
afraid about the theft of their credit card numbers. This is because the 
technologies that form the basis of E-Commerce can be used to obtain 
confidential information. Some of the issues of security in E-Commerce are 
discussed below. 
1. INTEGRITY 
Integrity refers to the ability to check and ensure that the data being 
displayed on a web site or what data is sent over the internet has not been 
changed in any way. This can be done if it is possible to authenticate and 
verify who sent the information and from which computer and that the 
information has not been tampered with.  
All those who want to use E-Commerce will be harboring suspicions on the 
integrity of the system. Only those with the authority to access and alter 
the data should be capable of doing so. If this power falls in the wrong 
hands, the threat to the integrity of the system is very real and can be very 
dangerous. A digital signature is normally used to ensure integrity of the 
message and this is discussed later in this chapter. 
2. NON REPUDIATION 
Non repudiation refers to the requirement that the parties who are doing 
E-Commerce, namely the buyer and the seller, do not deny that they have 
initiated the transaction.  
This means that the buyer should not deny placing the order and the seller 
should not deny that the order has been received. The main worry for the 
company doing E-Commerce is that the customer should not deny placing 
the order, as this will mean the company loses money on freight and 
packing. For the customer, the worry is of someone hacking into their 
account and placing an order on their behalf, and using their credit card 
number.  Thus non repudiation is used to ensure that the buyer and the 
seller cannot deny that the transaction has occurred. 
3. AUTHENTICITY 
Authenticity refers to the ability to determine the origin of the message 
received over the internet. This refers to knowing the identity of the 
person who has sent the message, from where the message was sent and 
the identity of the computer used to send the message.  
Proper identification is very important for both the parties dealing in E-
Commerce. It would help confirm whether the order received is genuine or 
not and would eliminate the possibility of fraud.  
4. CONFIDENTIALITY 
Confidentiality ensures that the message and data are viewed only by the 
person to whom they are sent and who has the authority to view them. 
These concerns regarding access to data and privacy are meant to ensure 
that within an organization no unauthorized person can lay their hands on 
such information. It is well known that there is very sensitive data, such as 
credit card details, which are sent as part of an E-Commerce transaction. It 
is important to ensure that even if the data is hacked into, it cannot be 
easily read. Normally to ensure confidentiality data encryption is used, 
which is discussed later. 
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5. AVAILABILITY 
Availability means that the E-Commerce systems are available 
continuously at all times when needed. The customer must get a fully 
functional E-Commerce site which works as it is intended to. It would be 
very irritating to the customer to see that the site is down due to some 
problem, when a transaction has to be urgently done. 
As long as all the above mentioned dimensions are functioning as intended 
there will be no security issue in E-Commerce. 
 

  d) Explain how an Online Credit Card Transaction Works? 
 (if any 4 points are covered give full 7 marks) 
1. The customer goes to the merchant’s website, selects the products to be 
purchased, by adding them to a shopping cart and then clicks on the button 
‘Proceed to checkout’. A secure and encrypted form opens on the web 
browser which is indicated on the screen, by a sign at the bottom. 
2. The customer enters in this form his name, address, credit card details 
i.e. Visa or MasterCard etc. the credit card number and expiration date etc., 
then clicks on the submit button. 
3. A secure tunnel is created through the internet using SSL for sending this 
card information and the payment application encrypts and transmits the 
credit card information to the merchant. 
4. The merchant sends this credit card information to a clearing house, 
which is a financial intermediary, which verifies card details and checks 
whether there is sufficient credit available for making the purchase. If 
there is insufficient balance on the card, a message declining the 
transaction is generated. 
5. The clearing house sends the information over the appropriate credit 
card network to the customers issuing bank for verification and payment. 
The customers issuing bank generates a confirmation number which is 
sent to the merchant via the clearing house.  
6. The merchant sends this confirmation number along with purchase 
order details to the customer and requests the customer to take a print out 
of this information for the customer’s record. The merchant then proceeds 
to shipping the order. 
7. At the end of the day the customer’s issuing bank sends the amount of 
the transaction to the clearing house. The clearing house credits the 
merchant’s bank with the amount and keeps a small percentage as 
processing fee. The customer’s issuing bank sends a monthly statement to 
the customer for payment which contains the details of purchases made 
during that month. 
 

 

      
Q3. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 

 
  a) Consider the following worksheet 

 A B C D E 

1 NAME CITY SALES COMMISSION BONUS 

2 RAHUL MUMBAI 80000   

3 ANJALI PUNE 100000   
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4 POOJA BANGLORE 50000   

5 RAJ HYDERABAD 95000   

6 KAJOL PUNE 200000   

7 ADITYA BANGLORE 300000   

8 SEEMA HYDERABAD 40000   

 
Write Steps to perform the following: 
i) To compute Commission @8% of sales whenever sales are below 

`75,000 otherwise @ 10% of Sales in column D. 

ii) To compute the Bonus as 2% of the Sales for Sales up to `50,000 

otherwise @ 5% of Sales in column E.  
Solution: 
(i)To compute Commission. 

1. Select D2 and type the formula 
            =IF (C2<75000, C2*8%, C2*10%) and press enter. 

2. Select D2 and drag the fill handle to D8. 
 (ii) To find Bonus. 

1. Select E2 and type the formula  
            =IF (C2<=500000, C2*2%, C2*5%) and press enter. 

2. Select E2 and drag the fill handle to E8. 
MARKS (4+4) 

 
 

  b) The following data has been entered in a worksheet. 
 

 A B C D E F G 
1 NAME TEST1 TEST2 TEST3 TEST 4 AVERAGE 

MARKS 
GRADE 

2 SAMIRA 66 77 70 70   
3 SAIRA 56 67 72 77   
4 NASIR 45 54 55 60   
5 NITIN 40 45 48 56   
6 SARITA 67 78 80 85   
7 ADIL 65 66 69 78   

Where Test1, Test 2, Test 3 and Test 4 are marks scored by the candidates 
in 4 tests.  
Write steps to  

i) Find the Average marks in column F. 
ii) Assign Grade in Column G using the following policy: 

Average Marks Grade 
80  or more O 
60 or more but below 80 A 
Less than 60 B 

 
 

i)Total Marks: 
1. Select F2 and type =Average (B2:E2) and press enter. 
2. Select F2 and drag the fill handle to F7. 

ii) Grade: 
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1. Select G2 and type =IF (F2>=80,”O”, IF (F2>=60,”A”,”B”)) and 
press enter. 

2. Select G2 drag the fill handle to G7. 
                                                                                                      MARKS (3+5) 

     
 (B)  Answer any one  sub-question from  c) and  d) in MS-EXCEL 

 
(7) 

  c) The following data has been entered in a worksheet. 
 A B C D E F G H 

1 NAME DESIGNATION HRA DA  DESIGNATION HRA DA 

2 SONU  PEON    PEON 4000 5000 

3 PINKY CLERK    CLERK 8000 10000 

4 RINKU CLERK    MANAGER 15000 20000 

5 SOPHIE MANAGER       

6 PREM PEON       

7 BINDU CLERK       

8 TINA MANAGER       

 

Write steps to find the HRA and DA in column C and D respectively using 
VLOOKUP function. Policy table to be referred for finding the HRA and DA 
is given in the range F2:H4. 
i)To calculate HRA  

1. Select C2 and type the formula 
=VLOOKUP(B2,$F$2:$H$4, 2,FALSE) 
OR =VLOOKUP(B2,$F$2: $G$4,2,FALSE) 

2. Select C2 and drag the fill handle to C8. 
ii)To calculate DA 

1. Select D2 and type the formula  
          =VLOOKUP(B2,$F$2:$H$4,3, FALSE)   

2. Select D2 and Drag the fill handle to D8. 
MARKS (4+3) 

 

     
  d) Consider the following worksheet 

 A B C D 

1 NAME MONTHLY SALARY ANNUAL INCOME INCOME TAX 

2 RAHUL 80000   

3 ANJALI 100000   

4 POOJA 50000   

5 RAJ 65000   

6 KAJOL 40000   

7 ADITYA 125000   

8 SEEMA 40000   
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   Write steps to calculate Annual Income in column C and Income Tax in 
column D where Income-Tax is calculated as follows. 
 

       Taxable Annual Income       Rate 
         First 1,00,000         Nil 
         Next 2,00,000        10% 
         Excess        20% 

 
Solution: 
i) To calculate Annual Income: 
1. Select C2 and type= B2*12 
2. Select C2 and drag the fill handle to C8. 
ii) To calculate Income Tax: 
=IF (C2<=100000, 0, IF (C2<=300000, (C2-100000)*.10, (C2-
300000)*.20+200000*.10))   and press enter. 
2. Select D2 and drag the fill handle to D8. 

                                                                            MARKS (2+5) 

 

     
Q4. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL 

 
(8) 

  a) The following data is entered in a worksheet regarding expenses (in `) 

during January, February, March and April. 
 

 A B C D E 
1 ITEM JAN FEB MAR APRIL 
2 EDUCATION 6000 6000 6000 6000 
3 FOOD 15000 16000 17000 16000 
4 RENT 45000 45000 45000 45000 
5 CAR 12000 15000 13000 14000 
6 TOTAL     

Write the steps to 
 i) Find the total expenses in each month in the cells B6, C6, D6 and E6. 
ii) Create 3-D Bar chart for expenses of January, February, March and April. 
iii) Create a Pie chart for the month of March. 
iv) Create a Line diagram for the months February and April. 
Solution: 
i) Find the total expenses in each month in the cells B6 to E6. 
     1. Select B6 and type =SUM (B2:B5) and press enter. 
     2. Select B6 and drag the fill handle to E6. 
ii) To create 3-D Column chart for expenses of January, February, March 
and April. 

1. Select the data A1:E5 (or A1:E6 or B2:E5).  
2. From the Insert tab, select Column chart, then select sub type 3-D. 

iii) To create Pie chart for the month of March. 
1. Select the data D2:D5 (or D1:D5) 
2. From the Insert tab, select Pie chart, then select any sub type. 

iv) To Create a Line diagram for the months February and April. 
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1. Select the data C2:C5 and E2:E5.  
2. From Insert tab select Line, then select any Sub type.   

                                                                                                         Marks 2+2+2+2 
  b) The following table shows Quantity, Unit Price, Income and total Income of 

a shopkeeper who sells rice, dal, sugar and tea. 
 

 A B C D E 
1 ITEM QUANTITY PRICE INCOME  
2 RICE 100 80 8000  
3 DAL 50 120 6000  
4 SUGAR 60 70 4200  
5 TEA 45 250 11250  
6      

 
Write steps to find Total Income in D6.   
Write steps in Excel using Solver to find how much quantity of rice, dal, 

sugar and tea should be sold in order to achieve total income of `50,000, 

assuming that quantity should be integer only. 
Solution: 
1. Select D6 and type = Sum (D2:D5) and press enter. 
2. Select D6 and from the Data Tab select Solver. 

3. In the dialog box in the ‘Set objective’ option the cell D6 is already selected. 

4. In the ‘To’ option select ‘Value of’ and type 50000 in the text box. 

5. In the option ‘By Changing Variable cells’ text box enter B2:B5. 

6. Then click on Solve. When Solver will obtain the result, click on ok.  

                                                                               Marks (step-wise) 1+1+1+2+2+1 

 

     
Q4. (B)  Answer any one  sub-question from  c) , d) in MS-EXCEL (7) 
  c) The following data has been entered in a worksheet 

 A B C D 

1 EMPNO NAME SALARY INCOME TAX 

2 E001 DOLLY 35000  

3 E002 ANJALI 55000  

4 E003 DIPALI 42000  

5 E004 RAJ 50000  

6 E005 KAJOL 52000  

7 E006 ADITYA 75000  

8 E007 REEMA 60000  

 
Write steps to do the following:- 

i) Display only those rows where the Salary is more than ` 50,000. 

ii)Display only those rows where the Salary is more than `45,000 but  

    less than `65,000. 

iii) Display only those rows where name do not start with “M”. 
Solution: 
i) Display only those rows where the Salary is more than 50,000. 
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  1. Select the data A1:C8. 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Salary and from number filter select  
       ‘greater than’. 
   4. Type 50000 in the dialog box and click on ok. 
ii) Display only those rows where the Salary is more than `45,000 but  
    less than `65,000. 
  1. Select the data A1:C8 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Salary and from number filter select  
       ‘greater than’. 
  4. Type 45000 in the dialog box and then select ‘And’. 
  5. Select ‘Less than’ 
  6. Type 65000 and click on ok. 
iii) Display only those rows where the name does not start with “M”. 
Solution: 
  1. Select the data A1:C8 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Name and from Text filter select              
‘does not begin with’. 
  4. In the dialog box type M and click on ok. 
                                                                                                     Marks 2+3+2 
 

  d) Explain the following functions in MS-EXCEL. 
   

1) TODAY() 2) COUNTBLANK() 3) SMALL() 4) YEAR() 
5) CORREL() 6) WEEKDAY() 7)DAY()  

 
(Give 1 mark if either definition or example or syntax is correct for each 
function) 
1) TODAY( ): Returns the current system date. 
     e.g. =TODAY() returns 16/11/2016 
2) COUNTBLANK(range): Counts the number of empty cells in a specified 
range of cells 
      e.g. COUNTBLANK(D1:D5) gives 3 if there are only two values in the 
cells from D1 to D5 
 
3) SMALL(array,k): Returns the kth smallest value in the data set  
e.g. = SMALL({45,23,67,87},3) gives 67 the 3rd smallest value  
4) YEAR(serial number): Returns the year corresponding to a serial 
number or date text. The year returned has a value from 1900-9999. 
e.g. =YEAR(“3-JUNE-2015”) gives 2015 
5) CORREL(array1,array2): Returns the correlation coefficient between 
two data sets.  
e.g. If D1:D3 contains the values 45,34,67 and E1:E3 contains the values 
49,44,75 then CORREL(D1:D3,E1:E3) gives .983358 the correlation  
coefficient between these two data sets. 
 We can also type =CORREL({45,34,67},{49,44,75}) which gives the same 
result .983358 
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6) WEEKDAY(serial_number, return_type): Returns the day of the week 
corresponding to a date. The day is given as an integer, ranging from 1 
(Sunday) to 7 (Saturday), by default. 
e.g. =WEEKDAY(“4/13/16”) gives 4 
7)Day(serial number): Returns the day of the month corresponding to a 
serial number or date text. e.g. =DAY(“11/16/2016”) gives 16. 
 

     
Q5. (A)  Answer any one  sub-question from  a) and b) in VISUAL BASIC 

 
(8) 

  a) Write a project in VB to accept students name and marks in Accounts, 
Economics and MHRM and then calculate total mark and percentage. 

Object Property Setting 

Form Name Frmpercntge 

 Caption Percentage 

Label Name Label1 

 Caption Accounts 

Label Name Label2 

 Caption Economics 

Label Name Label3 

 Caption MHRM 

Text Box Name TxtAccounts 

 Text (Blank) 

Text Box Name TxtEco 

 Text (Blank) 

Text Box Name TxtMhrm 

 Text (Blank) 

Label Name Label4 

 Caption Total Marks 

Label Name Label5 

 Caption Percentage 
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Text Box Name TxtTotalmarks 

 Text (Blank) 

Text Box Name TxtPercent 

 Text (Blank) 

Command Button Name CmdCalc 

 Caption &Calculate  

Command Button Name CmdExit 

 Caption &Exit 

 
Code 
Private Sub cmdCalc_click() 
Dim A,B,C As Integer 
Dim Totalmarks  As Single 
Dim Percent As Single 
A=Val(TxtAccounts.Text) 
B=Val(TxtEco.Text) 
C=Val(TxtMhrm.Text) 
 
Totalmarks=A+B+C 
Percent=(Totalmarks*100)/300 
TxtTotalmarks=FormatNumber(Totalmarks,2) 
TxtPercent.Text=FormatNumber(Percent,2) 
End Sub 
 
Private Sub CmdExit_Click() 
End 
End Sub 
(Minimum 2 marks may be given for attempting to answer the program) 
(4+3+1) 
 

  b) Write a project in VB to design a suitable form which user to enter three 
numbers in text boxes and find the maximum number among three.  
Solution:  
 

Object Property Setting 

Form Name FrmLargest 

 Caption Largest 

Label Name Label1 
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 Caption First Number 

Label Name Label2 

 Caption Second Number 

Label Name Label3 

 Caption Third  Number 

Text Box Name TxtNum1 

 Text (Blank) 

Text Box Name TxtNum2 

 Text (Blank) 

Text Box Name TxtNum3 

 Text (Blank) 

Label Name Label4 

 Caption Largest 

Command Button Name CmdLargest 

 Caption &Find Largest 

Command Button Name CmdExit 

 Caption &Exit 

 Code  
          Private Sub CmdLargest_Click() 

Dim a, b, c, largest As Integer 
a = Val(Txtnum1.Text) 
b = Val(TXtNum2.Text) 
c = Val(TxtNum3.Text) 
If a >= b And a >= c Then 
largest = a 
Else If b >= c Then 
largest = b 
Else 
largest = c 
End If 
End If 
MsgBox  “Largest No.    “ &Str(Largest) , vbOkOnly 

            End Sub 
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        Private Sub CmdExit_Click() 
        End 
        End Sub 
(Minimum 2 marks may be given for attempting to answer the program) 
(4+3+1) 
 

     
Q5. (B)  Answer any one  sub-question from  c) and d) in VISUAL BASIC (7) 
  c) Write a project to design a suitable form to allow the user to enter name of 

a salesperson and the total sales. Calculate and display the commission 
earned by the salesperson based on the following table. Use appropriate 
controls.  
 

Total Sales(Rs) Commission 
Less than or equal to 90,000 Nil 
Between 90,000 and up to 1,50,000 10 % 
More than 1,50,000 12% 

Solution: 

 

Code 

 

Private Sub cmdCalc_Click() 

Dim comm, tsales As Single 

tsales = Val(txtSales) 

If  tsales <= 90000    Then 

  comm = 0 

    Else 

 If tsales < 150000    Then 

  comm = 0.1 * tsales 

 Else 

  comm = 0.12* tsales 

 End If 

End If 

MsgBox "The total Commission is”&Str(comm) 

End Sub 

Private Sub CmdExit_Click() 
        End 
        End Sub 

Object Property Setting 

Form Name FrmComm 

Label Name Label1 

 Caption Enter  Name 

Text Name TxtSales 

Command Button Name CmdCalc 

 Caption &Calculate or Calculate 

Command Button Name CmdExit 
 Caption &Exit 
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(Minimum 2 marks may be given for attempting to answer the program) 
(2+4+1) 

  d) Write a project in VB to compute and display the sum of the series 
2 + 5 + 8 + 11 + ⋯ + 32 
Ans:  

Object Property Value/Setting 
Form Name Form1 
 Caption SUM OF SERIES 
Command Button Name CmdCalc 
 Caption &Calculate or Calculate 
Command Button Name CmdExit 
 Caption E&xit or Exit 

                                                                                                     2 Marks 
Private Sub cmdCalc_Click()                       (4 Marks) 
  Dim I, S  as Integer 
  S=0 
  For I=2  to 32 step 3 
  S = S + I 
  Next  I 
  MsgBox “Sum = “ &S, vbOKOnly 
End Sub 
Note: Any loop may be used. 
 
Private Sub cmdExit_click()                           (1 Mark) 
  End 
End Sub 
(Minimum 2 marks may be given for attempting to answer the program)  
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